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Notes To Readers

The CTC Monitor™ User Guide provides the following information:

Related Documents

Setting up and configuring computer - controller communications for CTC
Monitor

Monitoring controller resources and /0O devices

Using a Data Table and symbolic names in CTC Monitor
Creating and using register files

Creating custom menus

Using CTC Monitor as a DDE serverRelated Documents

The following documents contain additional information

For information on Quickstep, refer to the Quickstep™ Language and
Programming Guide.

For information on Quickstep editor user interface, refer to the Quickstep™

User Guide.

For information on the registers in your controller, refer to Register Refer-
ence Guide.

For information on your controller and its modules, refer to the appropriate
Installation and Applications Guide.

For information on Microsoft Windows or your PC, refer to the manuals
provided by the vendor.Book conventions

Notes to Readers

vii
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Notes to Readers

The following conventions are used in this book:

ALL CAPS BOLDFACE Identifies DOS, Windows, installation program file names.

Boldface Indicates information you must enter, an action you must perform,
or a selection you can make on a dialog box or menu.

Ttalics Indicates a word requiring an appropriate substitution. For ex-

ample, replace filename with an actual file name. It can also
indicate a manual, book, or chapter title.

Text Connected With Underlines

Indicates symbol names used in Quickstep programs. Step names
are ALL_CAPITALS. Other symbol names can be Initial Capitals
or lower_case.

SMALL CAPS

Identifies the names of Quickstep instructions in text.

Courier font

Identifies step names, comment, output changes, and Quickstep
instructions appearing in the Quickstep editor window or program
steps

ArtCode — DN-24

Identifies the file name of a particular graphic image.

How to Contact Control Technology Corporation

Control Technology Corporation is located in Massachusetts, and wer are open
from 8:30 a.m. to 5:00 p.m. eastern time. Contact us at 508 435-9595 and 800
282-5008 or Fax 508 435-2373

See us on the web at www.ctc-control.com.

Your Comments

We welcome your suggestions and comments about this or any other Control
Tech document. Comment forms are in the file called BUGRPT.WRI, which was
installed in your QSWIN directory during your Quickstep installation. you can
also email comments to techpubs@control.com.

viii
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Getting Started

Chapter 1
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Setting Up Computer—Controller Connections

CTC Monitor can be set up to communicate with a controller through an RS-232
port or on an Ethernet network. In either case, you must have set up the physical
connection between the computer running CTC Monitor and the controller you
want to monitor before you can use CTC Monitor to monitor the controller.

Using the RS-232 Port for CTC Monitor — Controller Communications

Your controller is equipped with a built-in protocol allowing direct computer
communications with the controller’s RS-232 port. This protocol is described in
the Guide to CTC Serial Data Communications.

The connection to the controller’s RS-232 port is made
via a modular jack on the controller (labelled COMM).
This jack carries the receive signal, two grounds, and
the transmit signal for the communications channel.

The pin connection diagram illustrates the wiring of the
jack. Only the center four conductors of a six-conductor
jack are used. For more information, refer to the instal-

lation guide for your controller. - TxD outbound

2
3 - Ground
A series of standard Control Tech. cables are available 4
for making connection to this jack (listed in the table 5
below). As an alternative, many commonly-available
telephone cables may be substituted.

- Ground
- RxD inbound

Util_3

If you have a Model 2600XM or 2700 controller you can also connect the
computer to an RS-232 port on a Model 2216 or Model 2716 RS-232 Communi-
cations Module or a Model 2217 or 2719 Ethernet Module.

Connecting to a D Connector
RS-232 ports on computers are usually brought out through 25-pin or 9-pin D
type connectors. There is a standard for wiring such connectors, followed by
IBM and many other PC manufacturers.

Control Tech. has adapters available, the model 2880A or -B, that connect
directly to a male 25-pin (-A version) or 9-pin (-B version) D connector. These
adapters provide a modular jack wired for compatibility with the COMM port.
To be fully compatible when using this adapter, the computer’s communications
port should be wired as a DTE device:

e Pin2=TxD
e Pin3=RxD
¢ Pin 7 = Ground.

NOTE: Do not connect the controller to a telephone line.

The following table lists the part numbers for 25-pin or 9-pin D type connectors
used for RS-232 connections.

Model Number Part

2280A 25-pin D connector
2280B 9-pin D connector
2881 5 foot communications cable
2882 15 foot communications cable
2883 25 foot communications cable
2 CTC Monitor™ User Guide
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Using Eithernet for CTC Monitor — Controller Communications

Model 2600XM and 2700 controllers can access an ethernet network for control-
ler-computer communications using an Ethernet module. The Model 2217
Ethernet module contains both 10Base2 and 10BaseT connections, as well as
two RS-232 ports. The Model 2717 Ethernet module has ten 100BaseT
cpmmectopm as well as two RS-232 ports. Using ethernet, you can use CTC
Monitor to communicate with any controller in your network.

NOTE: Even though there can be multiple controllers on a network, you can only communicate with
one controller at a time.

The connection to the controller Ethernet port uses for Ethernet IEEE 802.3
standard 10Base2, 10BaseT, and 100 BaseT connections. For additional infor-
mation about setting up Ethernet communications, refer to the installation and
applications Guide for your Ethernet module.

Getting Started
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Launching CTC Monitor

As part of the installation, MONSETUP.EXE creates a CTC Monitor Utility
icon in the CTC Tools program group. You can launch CTC Monitor as a stand
alone application or use it in conjunction with the Quickstep editor. To start CTC
Monitor as a standalone application:

From the Start menu, select CTC Monitor from the CTC Tools Product group
on the Programs menu. The CTC Monitor window appears.

[ CTC Monitor - COMM 1

File Caonfiguration Help

s |
{ Program Step Status m

NVRAM Module
| Suspond Monitoring |

Connected to COMM 1

kond

4 CTC Monitor™ User Guide
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[z CTC Monitor Utility Files Form

Please select the files that you wizh to load.

[ Custom Form 1 file NOT defined.
[ Custom Form 2 file NOT defined.
X :Symbol file CATEMPA~052.57M
[ Data Table file HOT defined.

Okay Cancel

To launch CTC Monitor when you are using the Quickstep editor:
Select Monitor Controller from the Project menu in the Quickstep editor.

If you have previously used CTC Monitor to monitor a controller, the
following box appears:

hon2

2. Select the appropriate response.

The CTC Monitor window appears.

[ CTC Monitor - COMM 1

File Caonfiguration Help

s |
{ Program Step Status m

NVRAM Module
| Suspend Monitoring |

Connected to COMM 1

Muon

Getting Started
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CTC Monitor Overview

CTC Monitor allows you to perform real time monitoring of a controller’s
resources. The resources available for monitoring include:

Flags

Digital I/O

Analog 1/0

Servo positions and errors
Data Table

All registers

You can configure the monitor program for either serial port access through
COMM ports 1 to 8 (baud rate selectable) or through an Ethernet connection.

The monitor utility also has the following features:

Displays a tree structure that shows the step numbers of the running tasks
and allows you to monitor the controller’s program status.

Allows real time data entry for registers with write access

Allows real time data entry to flags, analog and digital outputs, and servo
positions.

Allows real time data entry for the Data Table and the ability to download a
new Data Table into the controller.

Contains a built-in DDE (dynamic data exchange) server that allows data
exchange with another application (such as Excel) with your controller.

You can define two custom screens that can group up to 16 resources of any
type. These screens support bidirectional data transfer for the selected
resources. You can also save the screens definitions to disk and recall them
for later use.

Imports and displays the symbolic names used in your Quickstep 2.x pro-
gram.

Uploads values stored in general purpose registers from 1 to 1000 and
registers 32001 - 36000 into a text file, edit the values, and download them
back to the controller.

NOTE: Only 2700 series controllers support registers 32001 through 36000.

CTC Monitor™ User Guide
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CTC Monitor Window Overview

The following illustration shows the CTC Monitor window and describes the
different parts of the window.

[ CTC Monitor - COMM 1

L_File Canfiguration Help

s |
; Program Step Status m
S |

NVRAM Module
| Suspend Monitoring |

Connected to COMM 1

[0

Muon

1 Menu bar Contains the File, Configuration and Help menus. Opens a
Symbol Table or register file, uploads/downloads a register file,
configures CTC Monitor/controller communications, sets up
DDE communications, and displays the on-line Help file.

2 Selection buttons  Accesses the register, input, analog input, flag, output, analog
output, servo and custom menus for monitoring and changing

resources.
3 Program status Displays a listing, by tree structure, of the current running tasks
in the controller being monitored.
4 Data table Uploads or downloads a data table to and from the controller,

change it, or open an existing Data Table.
5 NVRAM module  Accesses the registers available on the NV Ram module.

6 Monitor button Toggles to suspend or resume communications between the
controller and CTC Monitor.

7 Controller status Displays status messages and user prompts.
8 Command buttons  Starts, stops, and resets the controller.

Getting Started
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Configuring Computer—Controller Communications

Before you can use CTC Monitor to monitor your controller, you must indicate
the type of communications used in the Configuration Setup dialog box. From
this dialog box you can specify the communications port used for RS-232
communications or the computer and controller node numbers for Ethernet
communications.

Configuring RS-232 Communications
To configure RS-232 communications:
1. From the Configuration menu select Change Configuration.

The Communication Setup dialog box appears.

[ Communication 5etup

Communication Pork: IEI]HH 1 'I Hozt Hode: I

Baud Rate Selected: Igﬁuu 'I Target Hode: I

IP Address: | Timeout [ms): [25n
Mumber of Flags: 2 Mumber of Analog Outs: ]
Humber of Inputs: 16 Humber of Prototype: 1]
Humber of Outputs: A8 Humber of HS Counters: 1]
Humber of Steppers: 7] Mumber of Thumbwheels: ]
Mumber of Servos: 2 Mumber of Dizplaysz: ]
Mumber of Analog Ins: [0 Controller Architecture: [EA
START input status: |Controller RUNNING
STOP input status: |Hurma| Mode
RESET input status: |Controller Status OK
STEF input status: |Controller mid-program

Exit |

2. Click the arrow on the right side of the Communication Port field to
display the choices for communications.

3. Select the communications port (COMM1 through COMMS).

4. Click the arrow on the right side of the Baud Rate Selected field to display
the baud rates.

5. Select the baud rate. The default is 9600 baud.
6. Select Ok.

Once CTC Monitor establishes communication with the controller, the
Configuration Setup up dialog box displays information about the controller.

8 CTC Monitor™ User Guide
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Configuring Ethernet Communications
To configure Ethernet communications:
1. From the Configuration menu select Change Configuration.

The Configuration Setup dialog box appears.

[~ Communication 5 etup

Communication Port: IEt[:HET 'I Host Mode: |-|

Baud Rate Selected: Igﬁm] 'I Target Node: ||]

IP Address: | Timeout [ms): [250
Mumber of Flags: 22 Mumber of Analog Outs: ]
Number of Inputs: 16 Mumber of Prototype: ]
Mumber of Outputs: 48 Mumber of HS Counters: ]
Humber of Steppers: 0 Humber of Thumbwheels: 1]
Humber of Servos: 2 Humber of Displays: 1]
Mumber of Analog Ins: [0 Controller Architecture: [EA
START input status: |Controller RUNNING
STOP input status: |Nurma| Mode
RESET input status: |Controller Status OK
STEP input status: |Controller mid-program

Exit |

2. Click the arrow on the right side of the Communication Port field to
display the choices for communications.

3. Select CTeNET, CTcUDP, or CTc¢TCP.
4. Enter the computer’s node number in the Host Node field.

5. Enter the controller’s node number in the Target Node field. The default
value is 1.

6. Set the Timeout value. The default value is 250 ms.
7. Select OKk.

Once CTC Monitor establishes communication with the controller, the
Configuration Setup up dialog box displays information about the controller.

Getting Started 9
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Displaying Controller Configuration Information

Once you have established communications with the controller, the Controller

Configuration dialog box displays information about the controller. To display
controller information, select Change Configuration from the Configuration
menu.

[ Communication 5etup

Communication Port: IEDHH 1 'I Hoszt Hode: I

Baud Rate Selected: Igﬁm] 'I Target Hode: I

IP Address: | Timeout [ms): [280
Mumber of Flags: 2 Mumber of Analog Outs: ]
MNumber of Inputs: 16 Mumber of Prototype: ]
Humber of Dutputs: 48 Humber of H5 Counters: 1]
Humber of Steppers: T Humber of Thumbwheels: 1]
Humber of Servos: 2 Mumber of Dizplays: ]
Mumber of Analog Ins: [0 Controller Architecture: [EA
START input status: |Controller BUNNING
STOP input status: |Normal Mode
RESET input status: |Controller Status OK
STEF input status: |Controller mid-program

Exit |

The Equipment List lists information about the various modules and resources
the controller contains:

Flags in the controller

Digital inputs and outputs

Stepping and servo motors

Analog inputs and outputs
Prototype modules, if any

High speed counting modules
Thumbwheels and numeric displays

It also lists the controller architecture code used by Control Tech.

The Operating Status lists the status of the controller’s dedicated inputs and
operating status of the controller. This information only appears for model
2800iEA, 2800EAXM, and 2400iEA controllers.

10 CTC Monitor™ User Guide
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The status indicators for the start, stop, reset, and step dedicated input change
from idle to active when a switch closure occurs on the dedicated input. You

cannot change the state of the dedicated inputs from this dialog box; that can

only be done by turning the appropriate input on or off.

Operating Status also lists the following information:

If the controller running, stopped, or waiting for an input
If it is in normal mode

If it status is Ok or if it has a fault condition

Where the controller is in its program

Getting Started
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Starting, Stopping, and Resetting the Controller

You can start, stop, or reset the controller from the CTC Monitor window by
selecting the Start, Stop, or Reset buttons. Pressing one of these buttons sends a
start, stop, or reset command directly to the controller. These buttons work

independently from the dedicated inputs.

[7= CTC Monitor - COMM 1

File Caonfiguration Help

s |
{ Program Step Status m

NVRAM Module
| Suspend Monitoring |

Connected to COMM 1

Muon

12
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Monitoring Registers

From the Register dialog box you can do the following:

e View the values stored in registers
* Store a new value in a register
» Store a value in an empty register.

You access the Register dialog box by selecting the Registers button on the CTC
Monitor window. The following illustration shows the register dialog box.

[ Begisters [ [O]

@7_Qisplay
0 S
—I]— =

<:)7 U —
(|
LU

R T | —
—
U —
o 4
— ®
U—
LU
L1
LU
U —
0 =

@ Dec |GoTo: i @

1 Display Toggles the register value list between decimal and
Hex notation.
2 Register name Displays the register names. If you don’t choose a
list symbol table, the names displayed default to reg_

plus the register number (reg_10). When you select
a symbol table, the list displays the symbol names
for the registers. To display an entire symbol name,
resize the window: only the name list will expand.

3 Register value Displays the current numeric value for the registers
list shown. When a new value is entered into the text

box, CTC Monitor downloads the value to the

corresponding register in the controller.

14 CTC Monitor™ User Guide
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4 Register number | Displays the register number.
list
5 Register jump Allows you to change the range of registers
box displayed. Entering a register number in the jump
box changes the range of registers displayed to start
with the number entered. If you enter a number that
exceeds the register listing, CTC Monitor displays
the last range of available registers.
6 Notation Indicates if the current register values are in decimal
indicator or Hex notation.

NOTE: You can only enter numbers as decimal values even if the Register dialog box is displaying
values as Hex notation.

Viewing Register Values

To view the values stored in registers, select the Registers button on the CTC
Monitor window. The Registers dialog box appears.

To display a new range of registers, enter the number of the register in the
Register Jump Box and press Enter.

Changing or Entering the Value in a Register
To enter or change a value in a register:
1. Select the Registers button on the CTC Monitor window.
The Register dialog box appears.

2. If necessary, enter the number of the register in the Register Jump Box and
press Enter.

3. Select the register box by double clicking it with the mouse.

[Mon21]
4.
5000
150000
100000 Mon22

5. Press ENTER.

CTC Monitor downloads the new value to the controller.

Monitoring Controller Resources and I/O Devices 15
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Monitoring Flags

From the Flags dialog box you can view or change the status of a flag. You
access the Flag dialog box by selecting the Flags button on the CTC Monitor
window. The following illustration shows the Flag dialog box:

[75| Flags

i

Clear
iSet

Clear
Set

i

i

|__Clear |
Clear
Clear

Set

Clear
Clear
|__Clear |

Clear

|GoTo: |1 @

1 Flag name list

Displays the flag names. If you don’t choose a
symbol table, the names displayed default to flag_
plus the flag number (flag_2). When you select a
symbol table, the list displays the symbolic names
for the flags. To display an entire symbolic name,
resize the window: only the name list will expand.

2 Flag state
button/list

Displays the current state for the flags shown. Flags
are either set or clear. When you change the state of
a flag, CTC Monitor downloads the new state to the
corresponding flag in the controller.

3 Flag number list

Displays the flag number.

4 Flag jump box

Allows you to change the range of flags displayed.
Entering a flag number in the jump box changes the
range of flags displayed to start with the number
entered. If you enter a number that exceeds the flag
listing, CTC Monitor displays the last range of
available flags.

16
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Viewing Flag States

To view the state of a flag, select the Flags button on the CTC Monitor win-
dow. The Flags dialog box appears.

To display a new range of flags, enter the number of the flag in the Flag Jump
Box and press Enter.

Changing the State of a Flag
To change a flag’s state:
1. Select the Flags button on the CTC Monitor window.
The Flags dialog box appears.

2. If necessary, enter the number of the Flag in the Flag Jump Box and press
Enter.

3. Use the mouse pointer to click the State Button of the flag whose state you
want to change.

Top_Axis_in_Moti Set

Bottom_Axiz_in_M Set
flag_3

flag_4 Set: | £
flag_3

The State Button changes and CTC Monitor downloads the changed state to
the controller.

Top_Axis_in_Moti Set
Bottom_Axiz_in_M Set
flag_3

flag_4
flag_5 i5et

MionZd

Monitoring Controller Resources and I/O Devices 17
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Monitoring Digital Inputs

The Digital Input dialog box allows you to monitor the current state of digital
inputs. You access the Digital Input dialog box by selecting the Input button on
the CTC Monitor window. The following illustration shows the Digital Input

dialog box:

[=] Digital Inputs

On
]
]
]
— OFF
On
{3
On
]
]{;
]
1]
]
{3
]
]

(==N TN [=pl (5, - TR (KR P

|GoTo: i @

hond

1 Digital input list

Displays the names of the digital inputs. If you don’t
choose a symbol table, the names displayed default to
in_ plus the input number and A for open inputs, or B
for closed inputs (in_1A or in_2B). When you select a
symbol table, the list displays the symbolic names for
the inputs. To display an entire symbolic name, resize
the window: only the name list will expand.

2 Digital input
State Buttons/
List

Displays the current state for the digital inputs
shown. ON means that the digital input is currently
pulled to Ground; OFF means that the digital input is
currently at + 24 volts.

3 Digital input
number list

Displays the input number.

4 Digital input
jump box

Allows you to change the range of inputs displayed.
Entering an input number in the jump box changes
the range of digital inputs displayed to start with the
number entered. If you enter a number that exceeds
the digital input listing, CTC Monitor displays the
last range of available digital inputs.

18
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Viewing Input States

To view the state of a input, select the Inputs button on the CTC Monitor
window. The Digital Inputs dialog box appears.

To display a new range of inputs, enter the number of the input in the Digital
Input Jump Box and press Enter.

Monitoring Controller Resources and I/O Devices
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Monitoring Analog Inputs

The Analog Input dialog box allows you to monitor the current value of an
analog input. You access the Analog Input dialog box by selecting the Analog Ins
button on the CTC Monitor window. The following illustration shows the
Analog Input dialog box:

[75] Analog Inputs P[=] ES
10000001 [ -
|M 2 e
10000001 B
10000001 g
10000001 [

13429 @3
33876 K
3044740 8 3
3044740 ®
Not Prezent g ;I
|GoTo: | @
[ong]

1 Analog input list

Displays the names of the analog inputs. If you don’t
choose a symbol table, the names displayed default to
ain_ plus the analog input number (ain_1). When you
select a symbol table, the Register menu displays the
symbolic names for the inputs. To display an entire
symbolic name, resize the window: only the name list
will expand.

2 Analog input
number list

Displays the numeric value for the analog input.

3 Analog input
number list

Displays the input number.

4 Analog input
jump box

Allows you to change the range of analog inputs
displayed. Entering a number in the jump box
changes the range of analog inputs displayed to start
with the number entered. If you enter a number that
exceeds the analog input listing, CTC Monitor
displays the last range of available analog inputs.

Viewing Analog Input Values
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To view the state of a input, select the Analog Ins button on the CTC Monitor
window. The Analog Inputs dialog box appears.

To display a new range of inputs, enter the number of the input in the Analog
Input Jump Box and press Enter
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Monitoring Digital Outputs

The Digital Output dialog box allows you to view the state of a digital output or
turn it on and off. You access the Digital Output dialog box by selecting the
Output button on the CTC Monitor window. The following illustration shows
the Digital Output dialog box:

@7
®7

[ Digital Dutputs

0 =~ NN = Ld fa =

Won10

1 Digital output
list

Displays the names of the digital outputs. If you
don’t choose a symbol table, the names displayed
default to OUT _ plus the output number and on or off
(OUT_1_OFF). When you select a symbol table, the
list displays the symbol names for the outputs. To
display an entire symbol name, resize the dialog box:
only the name list will expand.

2 Digital output
State Buttons/
List

Displays the current state for the digital outputs
shown. Digital outputs are either on or off. When you
turn an output on or off, CTC Monitor downloads the
new state to the controller, and the controller changes
the state of the corresponding output.

3 Digital output
number list

Displays the output number.

4 Digital output
jump box

Allows you to change the range of outputs displayed.
Entering an output number in the jump box changes
the range of digital outputs displayed to start with the
number entered. If you enter a number that exceeds
the digital output listing, CTC Monitor displays the
last range of available digital outputs.
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Viewing Output States

To view the state of an output, select the QOutputs button on the CTC Monitor
window. The Outputs dialog box appears.

To display a new range of outputs, enter the number of the output in the Output
Jump Box and press Enter.

Turning Digital Outputs On and Off
To turn change the output on or off:

1. Select the Outputs button on the CTC Monitor window.

The Digital Outputs dialog box appears.

2. If necessary, enter the number of the output in the Digital Output Jump
Box and press Enter.

3. Use the mouse pointer to click the State Button of the output you want to
turn on or off.

The State Button changes and CTC Monitor downloads the changed output
state to the controller.

On
On
On
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Monitoring Analog Outputs

From the Analog Output dialog box you can monitor the current value of analog
outputs and change their values. You access the Analog Output dialog box by
selecting the Analog Outs button on the CTC Monitor window. The following
illustration shows the Analog Output dialog box:

[7€] Analog Outputs I =] B3

Mot Prezent
Mot Prezent [l
Mot Prezsent B
Mot Prezent B
Mot Prezent B
Mot Prezent [l
Mot Prezent [l
Mot Prezent [lE

O [ =l | S| LT | | | Pl | =

| GoTo:

1 Analog output
list

Displays the names of the Analog outputs. If you
don’t choose a symbol table, the names displayed
default aout_ plus the analog output number(aout_2).
When you select a symbol table, it displays the
symbolic names for the outputs. To display an entire
symbolic name, resize the dialog box: only the name
list will expand.

2 Analog output
value list

Displays the current value for the analog outputs
shown. When you enter a new value for an output,
CTC Monitor downloads the new value to the
controller, and the controller enters the new value in
the corresponding output.

3 Analog output
number list

Displays the output number.

4 Analog output
jump box

Allows you to change the range of analog outputs
displayed. Entering a number in the jump box
changes the range of analog outputs displayed to start
with the number entered. If you enter a number that
exceeds the analog output listing, CTC Monitor
displays the last range of available analog outputs.
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Viewing Current Analog Output Values

To view the value of an analog output, select the Analog Outs button on the
CTC Monitor window. The Analog Outputs dialog box appears.

To display a new range of outputs, enter the number of the output in the Analog
Output Jump Box and press Enter.

Changing Analog Output Values

To change an output value:

1.

Select the Analog Outs button on the CTC Monitor window.
The Analog Outputs dialog box appears.

2. If necessary, enter the number of the output in the Analog Output Jump
Box and press Enter.
3. Use the mouse pointer to select the analog output whose value you want to
change.
1000 1
2200 2
1600 3
0 4
4. Type the new value.
5. Press Enter.
CTC Monitor downloads the new value to the controller.
1
2
3
4
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Monitoring Servo Motors

The Servo Motors dialog box allows you to view the current position of a servo
motor and monitor the servo error. You access the Servo Motor dialog box by
selecting the Servos button on the CTC Monitor window. The following illustra-
tion shows the Servo Motor dialog box:

[ ServoMotors

| Position: | Error:
1] 0
0 1]
H/A H/A
Mot Present QIIE H/A
Mot Prezent @[JF/ H/A

Not Present [T N7A —_ _@
Mot Prezent Q[P M/A

Mot Prezent QIFY M/A
Mot Present QLEL M/A
Mot Prezent @[F1 H/A
Mot Present [P/ H/A
Mot Present QLFL H/A
Mot Present [P/ H/A
Mot Present Q[IFS M/A
Mot Present QLEL H/A
Mot Present QLLEL M/A

Man11

1 Servo output list | Displays the servo names. If you don’t choose a
symbol table, the names default to servo_ plus the
servo number(servo_1). When you select symbol
table, the list displays the symbolic hames. To
display an entire symbolic name, resize the dialog
box: only the name list will expand.

2 Servo Position Displays the current servo position.
list
3 Servo error Displays the current error value for the servos.
value list

Viewing Servo Position and Error Values

To view servo position and error values, select the Servos button on the CTC
Monitor window. The Servo Motors dialog box appears.
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Monitoring NVRam Module Registers

From the NVRAM Module dialog box you can do the following:

*  View the values stored in the NVRAM registers 32001 through 48000
e Store a new value in a the NVRAM register
» Store a value in an empty the NVRAM register.

You access the NVRAM Module dialog box by selecting the NVRAM Module
button on the CTC Monitor window. The following illustration shows the
NVRAM Module dialog box.

: reg_32001

reg_32003
reg_32004
reg_32005
reg_32006
reg_32007

reg 32009
reg_ 32010
reg_J32011
reg_ 32012
reg_32013
reg_32014
reg_ 32015
reg_32016

[7E N¥YR AM Module M=l

=1=11=21=11=11=1 =2 =11 ==U‘II'\.'IF.|I'I=
nan

®

| GoTo: |32I]I]1

1 Register name
list

Displays the register names.

2 Register value
list

Displays the current numeric value for the registers
shown. When a new value is entered into the text
box, CTC Monitor downloads the value to the
corresponding register.

3 Register number
list

Displays the register number.

4 Register jump
box

Allows you to change the range of registers
displayed. Entering a register number in the jump
box changes the range of registers displayed to start
with the number entered.

Monitoring Controller Resources and I/O Devices
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Monitoring NV Ram Module Registers

Viewing an NVRAM Module Register Values

To view the values stored in registers, select the NVRAM Module button on the
CTC Monitor window. The NVRAM Module dialog box appears.

To display a new range of registers, enter the number of the register in the

Register Jump Box and press Enter.

Changing or Entering the Value in an NVRAM Module Register

To enter or change a value in an NVRAM Module register:
Select the NVRAM Module button on the CTC Monitor window.
The NVRAM Module dialog box appears.

1.

If necessary, enter the number of the register in the Register Jump Box and

press Enter.

Select the register box by double clicking it with the mouse.

reg_ GO0
WA
ACCEL

5000
100001
100000

Type the new value.

reg_ GO0
A
ACCEL

Press ENTER.

600
601

602

5000

150000

100000

600
601

602

CTC Monitor downloads the new value to the controller.
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Monitoring Program Step Status

CTC Monitor gives you real time monitoring of your Quickstep program. The
Program Status dialog box displays a list of the current running tasks. You
access the Program Status dialog box by selecting the Program Step Status
button on the CTC Monitor window. The following illustration shows the
Program Status dialog box:

[=] Step Status H[=]

Controller Running

WMon20
1 Program task Shows the tree structure of the current tasks running
list in the controller. The current step humber and

symbolic step hame are displayed for each task.
2 Program status Displays the current status of the controller being

list monitored. Any software faults and or changes in
controller status will be displayed in this message
area.

Monitoring Program Tasks

To view a tree structure of the current tasks and to monitor program status, select
the Program Step Status button on the CTC Monitor window. The Program
Status dialog box appears.

Reading System Fault Messages

When your controller has a fault condition, the Program Status List displays
messages that can help you diagnose the problem. The Program Status List
displays the step where the fault occurred and a message. A list of system default
messages is on the next page.

To obtain a system fault message, select the Program Step Status button on the
CTC Monitor window. The Program Status dialog box appears. To see an entire
fault message, expand the dialog box to full size and read the message in the
program status list.

Controller Software Faulted in step 31 11 Servolf 1 |3 Mot Ready
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Monitoring Program Step Status

The following is a list of system fault messages:

Illegal Function
Corrupt Program Data
Destination Step is Empty
Bad Thumbwheel Data
Step#1 is Empty
Too Many Tasks
No Such Stepper Motor
Motor Not Ready
Motor Unprofiled
. Servo# does NOT exist
. Servo# Is Not Ready
. Servo# Error
. Register# does NOT exist
. Data Table Column# does NOT exist
. Data Table Row# does NOT exist
. No Such Proto Board
. Illegal Sample Time
18. Analog Input# does NOT exist
19. Analog Output# does NOT exist
20. Display# does NOT exist
21. Digital Input# does NOT exist
22. Digital Output# does NOT exist
23. Thumbwheel# does NOT exist
24. lllegal Data Table Value
25. Message Transmitting Busy
26. Divide-By-Zero Error
27. Caused by Register# or Data Out Of Range
28. Watch dog / Hardware Fault
29. Error Network Fault
30. Network Access Timeout

ORI N B DD —
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File Menu Overview

From the File Menu you can do the following:

* Open a symbol table to use with CTC Monitor

* Open a register file

» Upload register values from the controller to create a register file
*  Download a register file to the controller

You access the File menu by selecting File on the CTC Monitor main window.
The following illustration shows the file menu:

[75] CTC Monitor - COMM 1

Configuration  Help
Open Symbal File...

:
.
i
Program Step Status m
T

NVRAM Module
| Suspond Monitoring |

Connected to COMM 1

Open Begister File...
Upload Register File
Download Register File

E xit

hon30

Open Symbol File: Opens an existing symbol table. When you select a
symbol table, CTC Monitor creates a database of symbols and uses it in the
symbolic names to identify controller resources.

Open Register File: Opens an existing register file using Notepad. Register
files must be text ((TXT) files.

Upload Registers: Uploads the current register values from registers 1
through 1000 and registers 32001 through 36000 from the connected con-
troller and creates a text (.TXT) file.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose
registers. Some older controllers do not contain 1000 general purpose
registers. Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values
in registers 32001 through 36000. It does not upload the values in registers
36001 through 48000.

Download Registers: Downloads an existing register file into the control-
ler. CTC Monitor requires text (.TXT) files for downloading.
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Opening a Symbol Table

From CTC Monitor you can open a symbol table and use the symbolic names
from a symbol table with the Quickstep program you are monitoring.

To select an existing symbol table and use it with CTC Monitor:
1. Select Open Symbol File from the File menu.

2. When the Open dialog box appears, select the symbol table you want,
changing directories if necessary.

3. Using the mouse click OK or press Enter to load the symbol table.

Working with Symbol Tables and Register Files
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Opening a Register File

From CTC Monitor you can open an existing register file and display it using
Notepad. A register file lists the register numbers and their values and must be a
text (.TXT) file.

To select an existing register file and view it using Notepad:

1. Select Open Register File from the File menu.

2. When the Open dialog box appears, select a filename from the File Name
list, changing directorys, if necessary.

3. Using the mouse click OK or press Enter to open Notepad and display the
register file.

Notepad displays the register file.
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Uploading Register Data and Creating a File

From CTC Monitor you can upload the current register values from registers 1
to 1000 and 36001 to 36000 from your controller and create a (.TXT) files.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose
registers. Some older controllers do not contain 1000 general purpose registers.
Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values in
registers 32001 through 36000. It does not upload the values in registers 36001
through 48000.

You must have version 2.7.1 of CTC Monitor to upload and download the values
in registers 26001 to 36000. To obtain the most recent version of CTC Monitor
download it from the customer area of the website.

To upload register values and create a register file:
1. Select Upload Register File from the File menu.

2. When the Save As dialog box appears, enter a filename, changing directo-
ries, if necessary

3. Using the mouse click OK or press Enter to save the register file.
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Downloading a Register File

From CTC Monitor you can down load an existing register file and place the
values into registers 1 through 1000 and registers 36001 through 36000 of your
controller. The Register files must be text (. TXT) files.

Model 2601, 2600, and 2700 controllers all contain 1000 general purpose
registers. Some older controllers do not contain 1000 general purpose registers.
Refer to the installation guide for your controller.

If you have an NVRAM module installed, CTC Monitor uploads the values in
registers 32001 through 36000. It does not upload the values in registers 36001
through 48000.

You must have version 2.7.1 of CTC Monitor to upload and download the values
in registers 26001 to 36000. To obtain the most recent version of CTC Monitor
download it from the customer area of the website.

To select an existing register file and download it to your controller:
1. Select Download Register File from the File menu.

2. When the Open dialog box appears, select a filename from the File Name
list, changing directories, if necessary

3. Using the mouse click OK or press Enter to download the register file.

The Status Message display lists the registers as CTC Monitor downloads
them to the controller. When CTC Monitor is finished downloading the
register file, the message, “Register write completed.” appears in the
Status Message display along with the number of the highest register
downloaded.
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Data Table Dialog Box Overview

From the Data Table dialog box you can do the following:

Load an existing a data table into the CTC Monitor workspace

Save a data table

Upload a data table from the controller

Download new values or messages to the data table in the controller
Cut, copy, and paste items in the data table

Monitor the data table in the controller

Specify the time interval used when monitoring a data table

Specify the starting and ending rows of the data table to monitor

You access the Data Table dialog box by selecting the data table button on the
CTC Monitor window. The following illustration shows the Data Table dialog

box:
[ Data Table M= E3
@7 Fil=  Edit Options Help
R : Caol=:
@7 'E?IEI J:'Il%lgl s |12 als:  |ag
Rowr # | 1 2 2 4 5 E Meszage
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2 1000 n} 1500 i} ol e
3 1500 ] =000 0 ol
4 2000 ul 22000 u] 33536 =21 [ IREEE TR LT LR
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T n} u] n} i} ol e
2 20 13 u] 0 0 =T
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1 Menu bar Contains the File, Edit and Option menus. These
menus allow you to open, save, upload or download a
data table and edit the contents of the data table. You
can also start, stop, set up data table monitoring.

2 Toolbar Gives you quick mouse access to many tools used in
the Data Table dialog box.

3 Data table rows | Displays the rows and columns in your data table.
and columns The data table is a two-dimensional array of numbers.

4 Message list Displays the ASCII character representation of the
data in each row of the table. You can use this area to
create messages for transmission to external devices.

The Toolbar

The Toolbar appears across the top of the Data Table dialog box below the menu

bar and contains the following tools:

Open Existing File - Opens an existing data table.

Save - Saves the data table using its current name.

Cut - Removes the selected text and places it on the Clipboard

Paste - Inserts the contents of the Clipboard in the data table.

B | 2] | | =] | @]

Copy - Copies the selected text and places it on the Clipboard

ik Rows: - Indicates the number of rows in the data table.

Cals:

E Cols: - Indicates the number of columns in the data table.
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NOTE:

Data Table Dialog Box Overview

Saving an Existing Data Table

To save a data table:

Do one of the following:

Changing the Font

Select Save from the File menu (shortcut, type CTRL + S).
Select the Save icon on the Toolbar.

The data table editor displays text in Courier font. You can change the default
font using the Font dialog box.

1. Select Font from the Options menu.

2. When the Fonts dialog box appears, select the Font, Font Style, Size, and

Color.
Font 2] |
Font: Font style:
| Bald (] 4 I
-ﬁ' Andale Maono | |Regular
Covrier _I [talic: Cancel |
T Courier Mew Bold
Fisedays Bold Italic
T Lucida Conzale
— Effectz — Sample
[ Stikeout
[ Underline
Caolar:
I- Black ;I Script:
hiond0

The Sample box displays the current font.

We do not recommend selecting the Strikeout or Underline effects.

3.

Select OK to apply your changes.

To exit with out saving your changes, select Cancel.
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Opening a Data Table File
From the Data Table dialog box you can open an existing data table.
To open an existing data table:
1. Select Open from the File menu.

The Load Data Table dialog box appears.

Load Data Table |

Laak in: I'a D spfiles j gl
|1 Qshackup: Olutex. tab test-tab TAB

53Eltal:u ...... Servoa.tab Hyzservo. tab
DemodE.tab Servo-rtab

Grinder. tab Servany.tab

Fuilti.tab Servonpz.tab

hew-servoryz.tab Test.tab

Flegane: | | Oeen |
Files of type: [0S Data Tables [“tab) =] — |

[~ Open az read-only

2. Choose the name of the data table from the Load Data Table dialog box and
select OK. If the data table is in a different directory, select the appropriate
directory.

CTC Monitor opens the data table.
Uploading and Downloading a Data Table

From CTC Monitor you can upload or download a data table from your control-
ler to the CTC Monitor Data Table dialog box. If there is not a data table open,
use the Open command from the File menu.

* To upload a data table, select Upload from the File menu. The uploaded
data table appears in the Data Table dialog box and the message, Upload
complete, appears in the Status Message Display on the CTC Monitor
Main window.

¢ To download a data table, select Download from the File menu. When CTC
Monitor has finished downloading the data table, the message, Download
complete, appears in the Status Message Display on the CTC Monitor
Main window.
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Entering Numbers and Messages

Entering and Editing Numbers in the Data Table

You can enter or edit a number by typing from the keyboard or pasting it from
the Clipboard.

To enter or edit a value:

1.

Entering Messages

Select the appropriate cell using the Arrow keys or mouse pointer.
The data table editor highlights the cell.

Type or paste the number and press Enter.

The number appears in the cell.

To enter a value in another cell, press Enter again to move to the next cell in
arow. You can also use the Arrow keys or mouse pointer to move to the
another cell.

To send the new values to the controller, select Download from the File
menu.

Using the Data Table dialog box, you can create messages for the data table.
The length of message (letters, numbers, and spaces) cannot be longer than the
number of columns in the table.

To enter a message:

1.

Select the message field by placing the mouse cursor in the message field
and click the mouse.

.................... Fiond]

The dots in the message indicate that the corresponding cell in the data table
does not contain a number which is an ASCII code for a printing character.

Type the message and press Enter.

CTC Monitor enters the message in the Data Table dialog box.

.................... [Mond2]

3. To send the message to the controller, select Download from the File menu.
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Realtime Data Table Monitoring

CTC Monitor also gives you real time monitoring of a data table. Using the data
table monitoring, you can check the current values in a data table while your
controller is running.

Setting the Data Table Monitor Parameters

Using the Monitor Setup dialog box, you can specify the monitor time interval
and the beginning and ending rows to be monitored. You access this dialog box
by selecting Monitor Setup from the Options menu. The following illustration
shows the Monitor Setup dialog box.

[ Data Table Monitor Setup |

Monitor Interval [ms]: |2|]|]|]
Starting Row to Monitor: |1
Ending Row to Monitor: |12

fond3

Monitor Interval: Specifies the data table monitor interval in milliseconds.
The default time interval is 2000 milliseconds (2 seconds).

Starting Row to Monitor: Specifies the starting row to monitor. CTC Monitor
only updates the data table rows specified. Specifying the rows to monitor
allows for the maximum update speed available.

Ending Row to Monitor: Specifies the ending row to monitor. CTC Monitor
only updates the data table rows specified.

To set the monitor parameters:

1. Select Monitor Setup from the Options menu. Then set the time interval,
starting and ending rows as necessary.

2. To specify the time interval, place the mouse pointer on the Monitor
Interval field and double click the mouse.

Type the time interval and press Enter.

4. To specify the starting or ending row to monitor, place the mouse pointer on
the Starting Row to Monitor or Ending Row to Monitor field and double
click the mouse.

5. Type the row number and press Enter.
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Realtime Data Table Monitoring

Starting and Ending Data Table Monitoring

When data table monitoring begins, CTC Monitor uploads data table from the
controller and displays it in the Data Table dialog box. CTC Monitor will
upload the data table at the time interval specified in the Monitor Setup dialog
box. When you cancel data table monitoring, the Data Table dialog box contin-
ues to display the last uploaded data table.

You can start and stop monitoring a data table as follows:

* To begin data table monitoring, select Begin Monitoring from the Options
menu.

* To end data table monitoring, select End Monitoring from the Options
menu.
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Custom Display Dialog Box Overview

CTC Monitor gives you the option of creating custom dialog boxes that allow
you to monitor a variety of controller resources, inputs, outputs, and servo
positions and errors values. To access the custom dialog boxes select the Custom
1 or Custom 2 buttons on the CTC Monitor window. Each custom dialog box
can list up to 16 different resources. You can create custom dialog boxes and
save them for monitoring different machines or processes.

There are two different Custom Display dialog boxes. The Resource Display
dialog box is for creating custom dialog boxes, and the Label Display dialog box
is used to view the information.

Resource Display Dialog Box

The following illustration shows the Resource Display dialog box:

[ Custom Screen 1 IS [=] E3

Eile  Display

Mot Selected
Mot Selected
Mot Selected
Mot Selected
Mot Selected
Hot-Selected
Mot Selected
Hot Selected
Mot Selected
Hot Selected
Mot Selected
Mot Selected
Mot Selected
Mot Selected
Mot Selected
Mot Selected

ok |k |k | od || k| —)

@@T

|1441441441141441

I I I I I I A

Maon13

1 File menu Contains commands that allow you to create a new
custom resource dialog box, save a new or existing
dialog box, and exit the Custom Resource dialog box.

2 Display menu Allows you to toggle between the Resource Display
and Label Display dialog boxes.

3 Resource list Displays a drop down list of controller resources.
When you select a resource, CTC Monitor evaluates
the resource number to make sure it is a valid
resource. The custom resource value list field
immediately displays the current value or state of the
resource.
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4 Resource Specifies and displays the number for the controller
number list resource chosen. You enter the number of the
resource you want in the appropriate text box. When
you enter the new resource number, the custom
resource value list field immediately displays the
current value or state of the resource.
5 Resource value | Displays the current value for the controller resource
list chosen. You may enter new values or change the
state of controller resources that accept input.

Label Display Dialog Box
The following illustration shows the Label Display dialog box.

[ Custom Screen 1 H=l

File  Dizplay

Flag 10 Clear

Reqgister 340 0
@— Register 341 0
in_1A 1
in_2B 0
@ cgistci 242 0

Hot Selected
Mot Selected

Hot Selected
Mot Selected
Hot 5elected
Mot Selected

Mot Selected

Mot Selected T

Mot Selected
Mot Selected

Mon1E

1 File menu Contains commands that allow you to create a new

custom resource dialog box, save a new or existing

dialog box, and exit the Custom Resource dialog box.

2 Display menu Allows you to toggle between the Resource Display

and Label Display dialog boxes.

3 Resource list Displays a list of controller resources using their

symbolic names.

3 Resource value | Displays the current value for the controller resource.
list You may enter new values or change the state of

controller resources that accept input.
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Custom Display Dialog Box Overview

Changing Values in a Custom Dialog box

Whenever CTC Monitor is communicating with a controller, the fields on the
Resource Value list display the current value or state of the resources on the
custom dialog box. You can change a value in a register or analog output or
change the state of a flag or digital output from a custom dialog box.

1. Place the mouse pointer in the Resource Value field and click the mouse.

2. Type in the new value or state of the resource and press the Enter.
Saving a New Custom Dialog Box

To save a new custom dialog box:

1. Select Save as or Save from the File menu.

2. When the Save As dialog box appears, enter a name for the new dialog box.

Save As |
Save jr: I {3 Dspfiles j EI
I [zbackup

File name: I Save I
Save as type: IEnnfig Filez[* CFG) j Canicel |

[T Open az read-only

3. Ifnecessary, select the correct directory.
4. Select OK.
Saving an Existing Custom Dialog Box

To save an existing custom dialog box, select Save from the File menu.
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Opening a Custom Dialog Box
You can display previously defined and saved custom dialog box by opening it.
To open a custom dialog box:
1. Select Custom 1 or Custom 2 from CTC Monitor window.

2. When the Resource Display dialog box appears, select Open from the File
menu.

When the Open dialog box appears, select the file you want to open. If
necessary, select a different directory.

open —— HH|
Lokin | 3 Dspfies = & g5
I:Iushackup

Fill_process.CFG

File name: Open I
Files of type: | Contfig Files(* CFG] [ Cancel
[T Open az read-only
3. Select OK or press Enter.
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Creating a Custom Dialog Box

When you create a new custom display dialog box, you start with an empty
Resource Display dialog box.

To create a new custom display dialog box:

1.
2.

Select Custom 1 or Custom 2 button on the CTC Montor window.

When the Label Display dialog box appears, select Display Resources from
the Display menu.

Display the drop down list of controller resources, by clicking on the Not
Selected field with the mouse.

Mot Selected -,

Hot Selected -
Flag —
Digital Input

Digital Output
Analog Input —
Analog Output
Reqister

Servo Position bl Maon14

Choose a resource from drop down list of controller resources.

Select the Resource Number field by placing the mouse pointer in the field
and clicking the mouse.

Type in the number of the resource and press Enter.

The Resource Value field immediately displays the current value or state of
the resource.

[75 Custom Screen 1 [_|Of x|
File  Dizplay
Flag =| |10 Clear
Register =| |340 1] [Maon15]

Continue selecting resources until you have defined your custom dialog box.

To save the dialog box, select Save from the File menu and enter a name for
the dialog box.
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Overview of the DDE Setup Dialog Boxes

From CTC Monitor you can use dynamic data exchange (DDE) to transfer
information and communicate with another application, such as WonderWare™,
Interllutions Fix™, Labview™, or Excel™. The DDE protocol permits two
applications to communicate by continuously and automatically exchanging data
through a DDE channel.

To establish DDE communications you must establish a channel, select a topic,
request and send data. The DDE channel must be specified in both applications
in order for them to exchange data.

There are two different DDE dialog boxes, the Flag Register Configuration
dialog box and the Block Write Configuration dialog box.

Flag Register Configuration Dialog Box

From the Flag Register Configuration dialog box you can set up a DDE conver-
sation that can read or change a specific flag or register. From this dialog box
you can also read the state of all the flags and specify a block of 50 registers to
be read at one time. The fields on the Flag Register Configuration dialog box are
shown below.

DDE Configuration - Comm 1

i 1 : 1 Block Write Configuration ]
@ Flag Write Address: I:l Flag Write Data: : @
@ Flag1: [0 0 0 0 0 0 0 0
Flag9: |0 0 0 0 0 0 0 0
Flag 17: |0 0 0 0 0 0 0 0
Flag 25: |0 0 0 0 0 0 0 0

Remster Wnte Address: 13002 Hemster Wnte Data: |
50 Reg Read Address: I:l Regizter Read Data: |

©©
o6

Regii: Reqister ¥alues:
1 0 0 0 0 0
3 5] 0 0 0 0 0
O 11 0 0 0 0 0
16 0 0 0 0 0
21 0 0 0 0 0
26 0 0 0 0 0
]| 0 0 0 0 0
36 0 0 0 0 0
11 0 0 0 0 0
46 0 0 0 0 0
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To set up a DDE conversation you must specify the application, the DDE topic,
and the item you want to set up a DDE link with. The table lists the application,
topic, and item for the Flag Register Configuration dialog box:

Field

Description

DDE Link

1 Flag Write
Address

Sets the flag address to write data to a
specific flag. The DDE conversation must
establish the correct flag address here
before sending the new data to the Single
Register Write Data box.

Application: CTCMON
Topic: DdeSetup
Item: FlagAddress

2 Flag Write
Data

Displays the current state of the flag
specified in the Flag Write Address box.
If the flag is set, its value is 1; if the flag
is clear, its value is 0.

Application: CTCMON
Topic: DdeSetup
Item: FlagWrite

3 Flag Data
List

Displays the flag data. If the flag is set, its
value is 1; if the flag is clear, its value is
0.

Application: CTCMON
Topic: DdeSetup

Item: FlagValue
(1-32,0=inactive)

4 Single
Register
Write
Address

Allows you to set the register address so
that the DDE conversation can write data
to a specific register. The DDE
conversation must establish the correct
register address here before sending the
new data.

Application: CTCMON
Topic: DdeSetup
Item: RegAddress

5 Single
Reqgister
Write Data

Allows the DDE conversation to change
the value for the register specified in the
Single Register Write Address box.

Application: CTCMON
Topic: DdeSetup
Item: RegWrite

6 Single
Register Read
Data

Displays the current value of the register
specified in the Single Register Write
Address box.

Application: CTCMON
Topic: DdeSetup
Item: RegRead

7 50 Register
Block Read
Address

Specifies a block of 50 registers to read.
The data for the 50 register block selected
is displayed in the Register Data listing.
Register block addressing may be used to
read registers 1 - 1000. Since the
registers are displayed in blocks of 50,
you must enter a value from 1 to 20 to
access the corresponding block of
registers. For example, entering 13
would display the values in registers 601
through 650.

Application: CTCMON
Topic: DdeSetup
Item: Reg50Address

8 Register Data
List

Displays the data for the register block
selected in the 50 register read address
box.

Application: CTCMON
Topic: DdeSetup

Item: RegValue
(1-50, 0 = inactive)
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Overview of the DDE Setup Menu
Block Write Configuration Dialog Box

From the Block Write Configuration dialog box you can specify a set of up to 16
registers to read and write to as a block. These registers can be any register in
the controller you have read or write access to. The following illustration lists
the fields on the Block Write Configuration dialog box.

DDE Configuration - Comm 1

Flag Register Configuration 1 ‘Block Wiite Confguration: 1
DDE Update Interval [ms]: Reglt: Write Yalue: Read Yalue:
® -
1 0
1 3 2 0 @
3 0
: ﬂ ®
Hetwork Hode Humber: [ 0
: ﬂ ®
© L ] 7 0
8 0
9 0
Connection made - Comm 1 10 0
11 0
12 0
@ 13 0
14 0
15 0
@ Start DDE 16 0
@ E it Wirite Block Data @

To set up a DDE conversation you must specify the application, the DDE topic,
and the item you want to set up a DDE link with. The table lists the application,
topic, and item for the Block Write Configuration dialog box.
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Field

Description

DDE Link

1 Update
Interval

Displays the current update time in
milliseconds that the DdeSetup screen
uses to update its controls. A value from
10 ms to 10000 ms (0.01 to 10 seconds)
may be entered using the scroll bar. 200
ms or greater interval recommended.

Application: CTCMON
Topic: DdeSetup
Item: Ddelnterval

2 Network
Node
Number

Displays the Ethernet node number of the
controller CTC Monitor is
communicating with.

Application: CTCMON
Topic: DdeSetup

Item: DDENode
(1-32767)

3 Message
Area

Displays the current state of the monitor
program communication with your
controller.

Application: CTCMON
Topic: DdeSetup
Item: Message

4 Start/Cancel
Button

Toggles between the monitoring of the
controller and the updating of the DDE
Setup screen. Any DDE conversation that
supports command execution can access
this button.

Application: CTCMON
Topic: DdeSetup
Item: START

5 EXIT Button

Exits the DDE Setup screen and returns to
the CTC Monitor main screen. Any DDE
conversation that supports command
execution can access this button.

Application: CTCMON
Topic: Ddesetup
Item: EXIT

6 Block
Register
Address

Allows you to specify which register
addresses to write data to during a Block
Register Write operation.

Application;: CTCMON
Topic: DdeSetup

Item: BlockAddress

(1 - 16, 0 = inactive)

7 Block
Register
Write Value

Allows DDE conversations to change the
value for the registers specified in the
Block Register Address boxes.

Application: CTCMON
Topic: DdeSetup

Item: BlockWrite
(1-16)

8 Block
Register Read
Value

Displays the values for the register
specified in the block register address
shown.

Application: CTCMON
Topic: DdeSetup

Item: BlockRead

(1- 16, 0 = inactive)

9 Write Block
Data Button

Writes all block write register data
changes. Any DDE conversation that
supports command execution can access
this button.

For applications that do not support
command execution through DDE
conversations, you can duplicate the
action of this button by writing the value
1 to the hidden WriteBox control.

Application: CTCMON
Topic: DdeSetup
Item: DOWNLOAD

Application;: CTCMON
Topic: DdeSetup
Item: WriteBox
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Opening a DDE Communications Channel

To establish DDE communications you must establish a channel, select a topic,
and request and send data. Depending on what type of information you want,
you may either leave the channel open to receive continual updates from the
controller via CTC Monitor or you can close the channel after the initial data
exchange. The DDE channel must be specified in both applications in order to
exchange data.

You open a DDE channel and establish communications from the Block Write
Configuration dialog box.

1.
2.
3.

Start CTC Monitor.
Select DDE Setup from the Configuration menu.

When the DDE Configuration dialog box appears, select the tab for the
Block Write Configuration dialog box.

Enter the update interval in the DDE Update Interval field.

The update interval is specified in milliseconds. CTC does not recommend
using an interval shorter than 200 milliseconds.

Select the Start DDE button by clicking it with the mouse.
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Reading Register Values Using a DDE Application

The following example shows how to use set up CTC Monitor and a DDE
application so that the DDE application can read register values from CTC
Monitor. It uses an Excel spreadsheet. The example creates a report which
tallies production results for the month and for the previous day.

Our report lists:
*  The total number of widgets produced this month and on the previous day
*  How many widgets failed the stress test this month and on the previous day

*  How many widgets failed the pressure test this month and on the previous
day

*  How many times on the previous day did the widget manufacturing ma-
chine jam and have to be reset

The information for this report is stored in registers 701 to 708 as follows:

Register 701: Monthly Widget Total
Register 702: Daily Widget Total
Register 703: Monthly Stress Failure
Register 704: Daily Stress Failure
Register 705: Monthly Pressure Failure
Register 706: Daily Pressure Failure
Register 708: Daily Machine Resets

Reading Register Values

To read register values from the controller via a DDE link to CTC Monitor,
follow these general steps:

1. Set up the Flag Register or Block Write Configuration dialog boxes by
specifying the registers you want the DDE application to read.

2. Set up and establish the DDE communications channel from CTC Monitor.
3. Setup the DDE application to read the registers.
4. Connect the DDE application to CTC Monitor.
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Reading Register Values Using a DDE Application

Setting up the Flag Register Configuration Dialog Box

The first step is to set up the DDE configuration in CTC Monitor. In this ex-
ample we show how to read register values from the Flag Register Configuration
dialog box. Register values are read from the Register Data List. This list is an
array of 50 register values, and the DDE link to it is:

Application: CTCMON
Topic: DdeSetup
Item: RegValue (1 - 50, 0 = inactive)

The registers are displayed in blocks of 50. To display registers 701 to 750, we
must set the 50 Register Block Read Address to 15.

To specify the block read address for a 50 register block:
1. Start CTC Monitor.

2. Select DDE Setup from the Configuration menu.
3. Select the Flag Register Configuration dialog box.
4

Select the 50 Register Block Read Address field by placing the mouse
pointer on it and clicking the mouse.

5. Enter a number from 1 to 20 indicating the 50 register block you want. We
entered 15.

6. Press Return.

The values in that block of registers appear in Register Data List.

Regizster Write Address: |12002 Reqister Write Data: I:l
50 Reg Read Address: I:l Regizter Read Data: I:l
Regit: Hemster ¥alues:

1 0 0 0 0 0

b 0 0 0 0 0

11 0 0 0 0 0

16 0 0 0 0 0

21 0 0 0 0 0

26 0 0 0 0 0

3 0 0 0 0 0

36 0 0 0 0 0

41 0 0 0 0 0

46 0 0 0 0 0

7. If not open already, open the DDE channel from CTC Monitor. See Opening
a DDE Communications Channel in this chapter.
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Setting up the DDE Application to Read the Flag Register Configuration Dialog Box
Once you have specified the registers you want and opened the DDE communi-
cations channel from CTC Monitor, you need to open the DDE application and
specify the application name, topic, and item you want to monitor. This example
uses an Excel spreadsheet, but CTC Monitor can communicazte with any
software application that uses the DDE protocol.

1. Open the DDE application and create the report or list you want.

Production Report
Monthly totals Monthly total

Failed stress test
Failed pressure test

Daily totals Daily total

Failed stress test
Failed pressure test
Machine resets

2. To start the DDE exchange, specify the application name, topic, and item for
the register in the Monthly total field.

=CTCMON|DdeSetup!‘RegValue(1)’

(1) specifies the first register in the Register Data List on the Flag Register
Configuration dialog box. Excel requires single quotes around RegValue(1)
when specifying an item from an array. Make sure you have the correct
format for your DDE application.

| Monthly total I=CTCMON|DdeSetup!'RegVaIue(1 )

If you have the DDE server running from CTC Monitor when you are setting
up your DDE application, the information from the controller appears in the
appropriate field.

Monthly total 4790

3. Specify the application name, topic, and item for the other registers.

NOTE: You can also specify the 50 Register Block Read Address from the DDE application. For more
information and an example, see Writing to CTC Monitor from a DDE Application in this chap-
ter.
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Reading Register Values Using a DDE Application

Setting Up the Block Write Configuration Dialog Box

Alternatively, we could use the Block Write Configuration dialog box and
specify only the registers we want to read. To do this, enter the register numbers
in the Block Register Address list. You can specify up to 16 different registers.
Once you have entered the register numbers, the Block Register Read Value list
displays the values in the registers.

You can then create a link from a DDE application and read the values displayed
in the Block Register Read Value list. The block register list is also an array. The
DDE link for reading this information is:

Application: CTCMON
Topic: DdeSetup
Item: BlockRead (1 - 16, 0 = inactive)

To select specific registers to read:

1. Start CTC Monitor.

2. Select DDE Setup from the Configuration menu.
3. Select the Block Write Configuration dialog box.
4

Select the Block Register Address list by placing the mouse pointer in the
Reg# field and clicking the mouse.

()]

Enter the register number in the Reg# field.
6. Press Return.

As you enter each register number, the value in that register appears in the
Block Register Read Value list.

7. Continue entering register numbers. The maximum number you can specify

is 16.
Regl: Write Yalue: Read Yalue:
Filll 4790
702 285
703 15
704 3
705 11
706 0
708 1 hon&T

8. Open the DDE channel from CTC Monitor. See Opening a DDE Communi-
cations Channel in this chapter.
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Setting up the DDE Application to Read the Block Write Configuration Dialog Box
This example sets up the DDE exchange for a series of registers specified on the
Block Write Configuration dialog box. Once you have specified the registers you
want and have opened the DDE communications channel from CTC Monitor,
you need to open the DDE application and specify the application name, topic,
and item you want to monitor. This example use an Excel spreadsheet, but you
can use any software application that uses the DDE protocol.

1.
2.

Open the DDE application and create the report or list you want.

To start the DDE exchange, specify the application name, topic, and item for
the register in the Monthly total field.

=CTCMON|DdeSetup!‘BlockRead(1)’

(1) specifies the first item in the block register address list on the Block
Write Configuration dialog box. Excel requires single quotes around
BlockRead(1) when specifying an item from an array. Make sure you have
the correct format for your DDE application.

I Monthly total I=CTCMONIDdeSetup!'BIockRead(1 )

If you have the DDE server running from CTC Monitor when you are setting
up your DDE application, the information from the controller appears in the
appropriate field.

Specify the application name, topic, and item for the next register.

NOTE: You can also specify the registers in the Block Register Address from the DDE application. For
more information and an example, see Writing to CTC Monitor from a DDE Application in this

chapter.
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Reading a Flag’s State from a DDE Application

You can read the state of a flag using a DDE application. Before you can read
flag states, you must open a DDE channel between CTC Monitor and the DDE
application. See Opening a DDE Communications Channel in this chapter.

Flag states are read from the Flag Data List. This list is an array of 32 values,
and the DDE link to it is:

Application: CTCMON
Topic: DdeSetup
Item: FlagValue (1 - 32, 0 = inactive)

To read a flag’s state set up the DDE application as follows:
1. Open the DDE application and create the report or list you want.

Status of Flags 1 through 6 Flag State
Flag 1 - Fill valve status

Flag 2 - Conveyer belt status

2. To start the DDE exchange, specify the application name, topic, and item for
the flag in the field.

=CTCMON|DdeSetup!'FlagValue(1)'

(1) specifies the first flag in the Flag Data List on the Flag Register
Configuration dialog box. Excel requires single quotes around FlagValue(1)
when specifying an item from an array. Make sure you have the correct
format for your DDE application.

| Flag 1 - Fill valve status I=CTCMONIDdeSetup!'RegVaIue(1)'

If you have the DDE server running from CTC Monitor when you are setting
up your DDE application, the information from the controller appears in the
appropriate field.

3. Specify the application name, topic, and item for the other flags.
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Writing Register Values Using a DDE Application

In addition to reading the values of registers, you may set up a DDE conversa-
tion with CTC Monitor to write values to registers. This is done by specifying
the DDE information for a specific register and then sending the changes to CTC
Monitor. You can set up the links to either the Flag Register Configuration
dialog box or to the Block Write Configuration dialog box.

In both cases you must specify the following information:
e The register number
e The new value for the register

e Assign a Visual Basic macro to send the register number and value to CTC
Monitor.

Once you have written the macro, you must design a method of executing the
macro. One method of executing the macro is to create a button and assign the
macro to it. For instructions on how to create a macro and execute it, see the
documentation for your DDE application. For sample macros, see Appendix B,
Sample Visual Basic Macros for DDE Applications.

Writing to the Flag Register Configuration Dialog Box from a DDE Application

When entering or changing register values using the Flag Register Configuration
dialog box, you need to specify the following information:

e The register number by writing to the Single Register Write Address. The
DDE information for this is:

Application: CTCMON
Topic: DdeSetup
Item: RegAddress

*  The new value by writing to the Single Register Write Data field. The DDE
information for this is:

Application: CTCMON
Topic: DdeSetup
Item: RegWrite

Before you can write new values to a register, you must open a DDE channel
between CTC Monitor and the DDE application. See Opening a DDE Communi-
cations Channel in this chapter.

To change a register value by writing to the Flag Register Configuration dialog
box:

1. Start the DDE application. This example uses Excel.

2. Enter the application name, topic, and item for the Single Register Write
Address field.

Number of widgets of each type to be produced
Register specifying number of type 1 widgets |=CTCMON|DdeSetup!RegAddress

Number of type 1 widgets |
1
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Writing Register Values Using a DDE Application

3.

Enter the application name, topic, and item for the Single Register Write
Value field.

Number of widgets of each type to be produced

Register specifying number of type 1 widgets |
Number of type 1 widgets |=CTCMONIDdeSetup!RegWrite

The DDE application displays the current Single Register Write Address and
the value in the register.

Create theVisual Basic Macros required to access the RegAddress and
RegWrite fields on the Flag Register Configuration dialog box. Refer to the
documentation for your DDE application for information on creating Visual
Basic Macros and see Appendix B for sample macros.

To specify a register, enter the register number in the RegAddress field.
To write a new value to the register, enter it in the RegWrite field.
Execute the Visual Basic Macros to send the information to CTC Monitor.

Once CTC Monitor receives the information, it downloads the new value to
the controller.
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Changing a Flag’s State from a DDE Application

You can change the state of a flag using a DDE application. Flag states are
displayed on the Flag Register Configuration dialog box and are changed by
specifying the following information:

*  The number of the flag you want to change in the Flag Write Address field.
The DDE link to the information is:

Application: CTCMON
Topic: DdeSetup

Item: FlagAddress
e The flag’s new state in Flag Write Data field. The DDE link to the informa-
tion is:

Application: CTCMON
Topic: DdeSetup
Item: FlagWrite

To download the new flag number you must write a Visual Basic macro. Once
you have written the macro, you must design a method of executing the macro.
In these examples, we create a button and assign the macro to it. For instructions
on how to create a macro and execute it, see the documentation for your DDE
application. For sample macros, see Appendix B, Sample Visual Basic Macros
for DDE Applications.

Before you can change flag states, you must open a DDE channel between CTC
Monitor and the DDE application. See Opening a DDE Communications Chan-
nel in this chapter.

To set up DDE to write to a specific flag:
1. Start the DDE application. This example uses Excel.

The Excel spreadsheet has two fields for each entry. The Flag number field
specifies the number of the flag, and the New state specifies the new state of
the flag.

2. Enter the application name, topic, and item for the Flag Write Address field.
=CTCMON|DdeSetup!FlagAddress

Change Flag Stage
Flag number |=CTCMONIDdeSetup!FIagAddress
New state |

|

3. Enter the application name, topic, and item for the Flag Write Data field.
=CTCMON|DdeSetup!FlagWrite

Change Flag Stage
Flag number |
New state [[=CTCMONIDdeSetup!FlagWrite

The DDE application displays the current flag number and state.
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Changing A Flag’s State from a DDE Application

4. Create theVisual Basic Macros required to access the FlagAddress and
FlagWrite fields on the Flag Register Configuration dialog box. Refer to the
documentation for your DDE application for information on creating Visual
Basic Macros and see Appendix B for sample macros.

5. To specify a flag number, enter it in the Flag number field.

6. To change the flag’s state, enter the new state in the New State field. Zero
(O) indicates that a flag is clear, and one (1) indicates that it is set.

7. Execute the Visual Basic Macros to send the information to CTC Monitor.

Once CTC Monitor receives the information, it downloads the information
to the controller.
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Installation Instructions




Installing CTC Monitor

For Windows 95, Windows 98 and Windows NT Users
To install the CTC Monitor software:

1.
2.

4.

Place the Quickstep CD into your CD drive.

When the automatic installation program window appears, use the mouse
pointer to select Install CTC Monitor 2.7 and click the Next button.

Follow the instructions on the screen. When asked, enter the following
information:

* The directory to contain the CTC Monitor files (default is C:\Program
Files\Ctcmon27)

*  The program group for the CTC Monitor icon (default is CTC Tools)

When the installation is complete, select Finish.

For Windows 3.11 Users
To install the CTC Monitor 2.4 software:

1.
2.

Place the Quickstep CD into your CD drive.

Open the File menu on the Program Manager and choose the Run com-
mand.

When the automatic installation program window appears, use the mouse
pointer to select Install CTC Monitor 2.4 and click the Next button.

Follow the instructions on the screen. When asked, enter the following
information:

*  The directory to contain the CTC Monitor files (default is
C:\QSWIN21\CTCMON)

*  The program group for the CTC Monitor files icon (default is Quickstep
2.1)

When the installation is complete, select Finish.
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Appendix B

Sample Visual Basic Programs

Contents

Opening a DDE Channel
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Opening a DDE Channel

Sub ctc_connect ()

"open a channel to CTCMON
'The value in ctc_channel contains the channel nunber

ctc_channel = DDElInitiate("ctcnon", "ddesetup")
End Sub
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Reset Value in Register

Sub ctc()

"The nmodule will set all specified CIC registers to the reset value defined
“in cell b2.

"get the users reset value fromcell b2
Set resetval ue = Wirksheets("Sheet1"). Range("b2")

"select the CTCMON register to be |oaded
DDEPoke ctc_channel, "Bl ockAddress(1)", Worksheets("Sheetl1").Range("C5")

"l oad the CTCMON register
DDEPoke ctc_channel, "BlockWite(1l)", resetval ue

"do the same for the rest of the registers
DDEPoke ctc_channel, "Bl ockAddress(2)", Wrksheets("Sheetl1").Range("C6")
DDEPoke ctc_channel, "BlockWite(2)", resetval ue

DDEPoke ctc_channel, "Bl ockAddress(3)", Wrksheets("Sheetl1").Range("Cr")
DDEPoke ctc_channel, "BlockWite(3)", resetval ue

DDEPoke ctc_channel, "Bl ockAddress(4)", Wrksheets("Sheetl1").Range("C8")
DDEPoke ctc_channel, "BlockWite(4)", resetval ue

DDEPoke ctc_channel, "Bl ockAddress(5)", Wrksheets("Sheetl1").Range("C9")
DDEPoke ctc_channel, "BlockWite(5)", resetvalue

Sample Visual Basic Programs
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Downloading Changes to the Controller

Sub downl oad()

"This nodule will downl oad new speadsheet changes to the controller
"through CTCMON

' Check bl ock#1
I f Worksheets("Sheet1").Range("e5") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("e5")
DDEPoke ctc_channel, "Bl ockAddress(1)", Wrksheets("Sheet1"). Range("C5")
DDEPoke ctc_channel, "BlockWite(1)", resetval ue
Wor ksheet s(" Sheet 1") . Range("e5") = ""
End If

' Check bl ock#2
If Worksheets("Sheet1").Range("e6") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("e6")
DDEPoke ctc_channel, "Bl ockAddress(2)", Wrksheets("Sheet1"). Range("C6")
DDEPoke ctc_channel, "Bl ockWite(2)", resetval ue
Wor ksheet s(" Sheet 1") . Range("e6") = ""
End If

" Check bl ock#3
If Worksheets("Sheet1").Range("e7") <> "" Then
Set resetval ue = Worksheet s("Sheet 1"). Range("e7")
DDEPoke ctc_channel, "Bl ockAddress(3)", Wrksheets("Sheet1"). Range("Cr")
DDEPoke ctc_channel, "BlockWite(3)", resetval ue
Wor ksheet s(" Sheet 1") . Range("e7") = ""
End | f

" Check bl ock#4
I f Worksheets("Sheet1").Range("e8") <> "" Then
Set resetval ue = Worksheet s("Sheet 1"). Range("e8")
DDEPoke ctc_channel, "Bl ockAddress(4)", Wrksheets("Sheet1"). Range("C8")
DDEPoke ctc_channel, "Bl ockWite(4)", resetval ue
Wor ksheet s(" Sheet 1") . Range("e8") = ""
End | f

' Check bl ock#5
I f Worksheets("Sheet1").Range("e9") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("e9")
DDEPoke ctc_channel, "Bl ockAddress(5)", Wrksheets("Sheet1"). Range("C9")
DDEPoke ctc_channel, "Bl ockWite(5)", resetval ue
Wor ksheet s(" Sheet 1") . Range("e9") = ""
End If

' Check bl ock#6
If Worksheets("Sheet1").Range("el0") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el0")
DDEPoke ctc_channel, "Bl ockAddress(6)", Wrksheets("Sheetl1").Range("Cl0")
DDEPoke ctc_channel, "Bl ockWite(6)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el10") = ""
End If

' Check bl ock#7
I'f Worksheets("Sheet1").Range("ell") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("ell")
DDEPoke ctc_channel, "Bl ockAddress(7)", Wrksheets("Sheetl1").Range("Cl1")

DDEPoke ctc_channel, "Bl ockWite(7)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el11") = ""
End | f
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' Check bl ock#8
If Worksheets("Sheet1").Range("el2") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el2")

DDEPoke ctc_channel, "Bl ockAddress(8)", Wrksheets("Sheetl1").Range("Cl2")

DDEPoke ctc_channel, "Bl ockWite(8)", resetval ue
Vorksheet s("Sheet 1") . Range("el2") = ""
End | f

' Check bl ock#9
I'f Worksheets("Sheet1").Range("el3") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el3")

DDEPoke ctc_channel, "Bl ockAddress(9)", Wrksheets("Sheetl1").Range("Cl3")

DDEPoke ctc_channel, "Bl ockWite(9)", resetval ue
Vorksheet s("Sheet 1") . Range("e13") = ""
End | f

" Check bl ock#10
I f Worksheets("Sheet1").Range("eld4") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el4")
DDEPoke ctc_channel, "Bl ockAddress(10)", Wrksheets("Sheetl1").
DDEPoke ctc_channel, "Bl ockWite(10)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el4") = ""
End | f

' Check bl ock#11
I f Worksheets("Sheet1").Range("el5") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el5")
DDEPoke ctc_channel, "Bl ockAddress(11)", Wrksheets("Sheetl1").
DDEPoke ctc_channel, "BlockWite(11)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el5") = ""
End If

' Check bl ock#12
If Worksheets("Sheet1").Range("el6") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el6")
DDEPoke ctc_channel, "Bl ockAddress(12)", Wrksheets("Sheetl").
DDEPoke ctc_channel, "BlockWite(12)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el6") = ""

End |f

" Check bl ock#13
I'f Worksheets("Sheet1").Range("el7") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el7")
DDEPoke ctc_channel, "Bl ockAddress(13)", Wrksheets("Sheetl").
DDEPoke ctc_channel, "BlockWite(13)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el7") = ""
End | f

' Check bl ock#14
I f Worksheets("Sheet1").Range("el8") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el8")
DDEPoke ctc_channel, "Bl ockAddress(14)", Wrksheets("Sheetl1").
DDEPoke ctc_channel, "BlockWite(14)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el18") = ""
End | f

' Check bl ock#15
I f Worksheet s("Sheet1").Range("el9") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("el9")
DDEPoke ctc_channel, "Bl ockAddress(15)", Wrksheets("Sheet1").
DDEPoke ctc_channel, "Bl ockWite(15)", resetval ue
Wor ksheet s(" Sheet 1") . Range("el19") = ""
End If

Range( " C14")

Range( " C15")

Range(" Cl16")

Range(" CL7")

Range( " C18")

Range( " C19")
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Downloading Changes to the Controller

' Check bl ock#16
If Worksheets("Sheet1").Range("e20") <> "" Then
Set resetval ue = Worksheet s("Sheet1"). Range("e20")
DDEPoke ctc_channel, "Bl ockAddress(16)", Wrksheets("Sheet1").Range("C20")
DDEPoke ctc_channel, "BlockWite(16)", resetvalue
Wor ksheet s(" Sheet 1") . Range("e20") = ""
End If

"wite a value to the witebox to trigger the downl oad from CTCMON DDEPoke

ctc_channel, "WiteBox", resetvalue
End Sub
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Resetting the Values in the Controller

Sub ctc_

updat e()

Set resetval ue = Wirksheets("Sheet1"). Range("b2")

DDEPok e
DDEPok e
DDEPoke
DDEPoke
DDEPok e
DDEPok e
DDEPoke
DDEPoke
DDEPok e
DDEPok e
DDEPoke
DDEPoke
DDEPok e
DDEPoke
DDEPoke
DDEPoke
DDEPok e

' DDEPoke ctc_channel
' DDEPoke ctc_channel

End Sub

ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel
ctc_channel

"Bl ockAddress(1)"
"Bl ockAddress(2)"
"Bl ockAddress(3)",
"Bl ockAddress(4)"
"Bl ockAddr ess(5)"
"Bl ockAddr ess(6)"
"Bl ockAddress(7)",
"Bl ockAddress(8)",
"Bl ockAddr ess(9)"
"Bl ockAddr ess(10)"

Vor ksheet s
Vor ksheet s
Wor ksheet s
Wor ksheet s
Vor ksheet s
Vor ksheet s
\Wor ksheet s(" Sheet 1"
\Wor ksheet s(" Sheet 1"
Wor ksheet s(" Sheet 1"
Wor ksheet s(" Sheet 1"

" Sheet 1"

NN N =~ A~

"Bl ockAddress(11)", Worksheets(" Sheet1"
"Bl ockAddress(12)", Worksheets(" Sheet 1"
"Bl ockAddress(13)", Worksheets(" Sheet 1"
"Bl ockAddress(14)", Worksheets(" Sheet 1"
"Bl ockAddress(15)", Worksheets(" Sheet 1"
"Bl ockAddress(16)", Worksheets(" Sheet 1"
"WiteBox", resetvalue

"regwite", ResetValue

"Flagwite", ResetValue

"Sheet 1").
"Sheet 1").
"Sheet 1").
" Sheet 1").
"Sheet 1").
)
)
)
)

)
)
)
)
)
)
)

Range(" C5")
Range(" C6")
Range(" C7")
Range(" C8")
Range(" C9")
. Range(" C10")
. Range("C11")
. Range("C12")
Range(" C13")
. Range(" C14"
. Range(" C15"
. Range(" C16"
. Range(" CL7"
. Range(" C18"
. Range(" C19"
. Range(" C20"
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Changing the State of an Output

Sub out put _t oggl e()
"This nodule will toggle a controller output.

Di m outval As Variant
Set regnum = Worksheet s(" Sheet 1"). Range("A5")

‘get the output nunber fromcell "A5"
DDEPoke ctc_channel, "regaddress", regnum'load the register number to CTCMON
outval = DDERequest(ctc_channel, "regread") 'read the current output state

outvalue& = (1 - Val (outval (1))) 'invert the state of the output

Wor ksheet s(" Sheet 1") . Range("Al1") = outval ue&

"l oad the new state value cell "Al"

DDEPoke ctc_channel, "regwrite", Worksheets("Sheetl").Range("Al") 'load the new

End Sub
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Changing the State of a Flag

Sub Flag _dick()

"This nodule will wite to the controller's flags based
‘on the nunber and state defined by the user

Dim flagval As Variant

Set regnum = Worksheet s(" Sheet 1"). Range(" D32")

DDEPoke ctc_channel, "flagaddress"”, regnum

DDEPoke ctc_channel, "flagwite", Worksheets("Sheetl"). Range("D33")

End Sub

Sub flag toggle()

Dimflagval As Variant

Set regnum = Worksheet s(" Sheet 1"). Range("A6")

DDEPoke ctc_channel, "regaddress", regnum

flagval = DDERequest(ctc_channel, "flagvalue(1)")

flag value = (1 - Val (flagval (1)))

Wor ksheet s(" Sheet 1") . Range("Al") = flag_val ue

DDEPoke ctc_channel, "flagwite", Worksheets("Sheet1").Range("Al")

End Sub
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Control Technology Corporation proprietary. Reproduction or distribution forbidden.

77






Index




Index

A
Analog inputs
monitoring 20
viewing states of 21, 23
Analog outputs
changing value of 25
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